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Happy Holidays!

Welcome to the latest edition of my monthly Final Cut Studio newsletter for December, 2007.

The goal of this newsletter is to provide information helpful to the professional user of 
Final Cut Pro. This newsletter publishes each month. Past issues are not archived. 
However, key articles are posted on my website for your reference. All software 
references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We are approaching 
200 tutorials to help you get the most out of Final Cut!
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Welcome!

This holiday season, I wish you the very best of times and a highly successful 2008! 2007 has been a 
great year for us, and things are looking truly exciting in 2008.

Let me get right to our two big announcements.

[ Go to Top. ] 

Digital Production BuZZ Joins Larry Jordan & Associates, Inc.

I am delighted to announce that Creative Planet's Digital Production BuZZ has joined our company.

Founded by Philip Hodgetts, industry-leader Digital Production BuZZ offers live, interactive, Internet 
talk radio focused on digital production, post-production, and distribution. Digital Production BuZZ was 
the first podcast on air about digital production and remains the leader of programming related to the 
subject. New shows are released every week.

Creative Planet's Digital Production BuZZ is part of a family of magazines and websites managed by 
New Bay Media, including DV Magazine, 2-pop.com, and Government Video. While the BuZZ remains a 
separate entity from New Bay Media, it is very nice to be able to share resources when necessary.

In addition to the podcast, Digital Production BuZZ also publishes a bi-weekly Tips and Tricks 
Newsletter focused on digital post-production; including articles on industry news, distribution, After 
Effects, Avid, Adobe Premiere, and Apple's Final Cut Studio.

What is most exciting is that the podcast and newsletter combination compliments our existing training, 
writing, and seminars, allowing us to provide you with even more timely information on our rapidly 

http://www.digitalproductionbuzz.com/
http://www.nbmedia.com/web_apps/portal/
http://www.dv.com/
http://www.2-pop.com/
http://www.governmentvideo.com/
http://www.digitalproductionbuzz.com/Newsletter/
http://www.digitalproductionbuzz.com/Newsletter/


changing industry. 

Click here to read the press release.

Click here to visit the BuZZ website.

New shows air live every Thursday at 6 PM PST. Click here to see what's on the next show.

PROGRAM NOTES

Jan. 3 - Year-in-Review. Listen as Philip Hodgetts, Mike Horton, Doug Bankston, 
Stacey Parks, and Larry Jordan discuss "2007-The-Year-That-Was." 

Jan 10 - Richard Townhill, Apple's Director of Pro Video Product Management and a 
senior member of the Final Cut team, will be interviewed on The BuZZ. Tune in to hear 
how the Final Cut team views our industry and where he thinks it is headed. 
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Larry's Final Cut Studio Seminars Return to the UK

By popular request, we are 
bringing our highly successful 
PowerUP with Final Cut 
Studio seminars back to the 
UK. 

If getting the most out of Final Cut is important to you or your business, then these seminars are 
essential.

I was delighted with the response to our UK visits last year and I'm looking forward to traveling again 
this year. We will be visiting four cities, with four seminars in each city:

�●     Birmingham, UK -- Feb. 8 & 9
�●     Leeds, UK -- Feb. 4, 5
�●     London, UK -- Feb. 11, 12
�●     Glasgow, Scotland -- Feb. 14, 15

Seminars in each city include:

�●     Optimize Your Editing (or, as the Brits write it: "Optimise")
�●     Enhance Your Look with Colour Correction
�●     Mastering Final Cut Studio 2

Both Optimize and Mastering have been updated to include all the latest features in the most recent 
updates to Final Cut Studio 2. And, we created an all-new seminar focused on color correction. 

Plus, for editors with tight schedules, we are repeating our most popular Optimize seminar once in the 
morning and once in the evening to make it even more convenient to attend.

NOTE: This is the only trip we are planning to Europe this year; also, our North American 
tour won't start until the Fall of 2008.

http://www.larryjordan.biz/about/press/2007_12.pdf
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/LiveThisWeek/
http://www.larryjordan.biz/sem/2008_uk_agendas.html
http://www.larryjordan.biz/sem/2008_uk_agendas.html
http://www.larryjordan.biz/sem/2008_uk_agendas.html


Save 15% if you register to attend more than one seminar.

Save an ADDITIONAL 15% if you register BEFORE January 1, 2008. Register now - save 30%! 

Click here to learn more: www.larryjordan.biz/uk 

Click here to see the agendas: www.larryjordan.biz/sem/2008_uk_agendas.html 

Click here to register: www.larryjordan.biz/seminarorderform.php

I'd love to see you there!
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QuickTime 7.3.1 Warning

Apple recently published a warning about problems with Flash and QuickTime 7.3.1. You can read more 
about it here: http://docs.info.apple.com/article.html?artnum=304445

UPDATE - Dec. 27, 2007

Tom Wolsky adds:

There are also problems capturing with QT 7.3 and earlier versions of Final Cut Pro and 
Express, which usually meant downgrading to QT 7.2. 
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Viewing 16:9 Video in QuickTime

I've suddenly gotten a whole flock of these questions. Yariv Newman's question is typical:

When I am doing editing and rendering of my project to show the client I can't get 
Quicktime to maintain the 16X9 aspect upon export. I've tried clicking on preserve aspect 
but it changes to 4:3. I am using the latest FCP. 

Larry replies: Yariv, QuickTime always displays video using square pixels. So, if you are using a format 
that uses rectangular pixels: HDV, DVCPRO HD, and many others, QuickTime won't show the correct 
aspect ratio.

However, Final Cut, DVD Studio Pro and other video playback applications take the aspect ratio of the 
pixel into account to make sure the display is formatted properly.

UPDATE - Dec. 27, 2007

Tom Wolsky writes:

You can export using QuickTime Conversion and force the file into the correct aspect 
ratio by changing the frame size, or you can fix it in movie properties of the QuickTime 
player. 

http://www.larryjordan.biz/uk
http://www.larryjordan.biz/sem/2008_uk_agendas.html
https://www.larryjordan.biz/seminarorderform.php
http://docs.info.apple.com/article.html?artnum=304445


Savic Dejan then added:

Getting QuickTime to display 16:9 video is actually quite simple:

�●     Open the movie in QuickTime 
�●     Type Command+J (or go to Window > Show Movie Properties) 
�●     Select the Video Track
�●     Click the "Visual settings" tab
�●     For PAL SD: enter 1024 x 576 in the "Scaled Size" boxes
�●     For NTSC SD: enter 853 x 480 in the "Scaled Size" boxes 
�●     Uncheck "Preserve Aspect Ratio"
�●     Select File > Save as and save your movie as "Self-contained"

That's it. 

Claes Jonasson adds:

BTW, while in this window in QuickTime, you should also select the High Quality box, so 
the movie will play back at its highest quality (rather than a lower res version to save 
processor effort). 

Larry replies: True, you can adjust the aspect ratio as described here. However, that doesn't deny the 
basic point that QuickTime does not, by default, display 16:9 video correctly. 
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New Snapping Feature in Final Cut Pro 6.0.2

There's a new feature that just showed up in the Final Cut Pro 6.0.2 update: pressing the Option key 
while dragging a clip temporarily turns Snapping on. 
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Technique: Adding a Watermark to Video

A question that I get asked frequently is how to add a watermark to video. For instance, all our Edit Well 
video tutorials use watermarks to reinforce the Edit Well logo and brand; or to show the original source 
of a video. While watermarks can be created in Final Cut, FCP always requires rendering before output 
which slows things down.

There's a much easier way using Compressor. This technique works in both Compressor 2.1x and 3.0x. 

For me, watermarks work best if they are simple in design and white in color. This gives me the greatest 
range in what they can be superimposed over. While Compressor can work with any design or color, I 
tend to keep my watermark designs simple. Also, I will create a watermark file for each position I want to 
place a watermark, for example, lower left, lower right, and center. Yes, Compressor can adjust 
watermark position, but I like to have more control over image placement than Compressor provides.

Here's a watermark example using a recent tutorial I did for Edit Well.

1) To help me set placement, I exported a still frame from my video, loaded it into 



Photoshop and set it as the background layer. This isn't required but really helps in 
determining positions. (You may need to scale the image to compensate for the 
difference in aspect ratio between video and Photoshop images.) 

2) I then created a new layer and created my watermark graphic in the position, rotation, 
and the size I want. Because Photoshop layers retain all their transparency (alpha 
channel) information when they are imported into Compressor, the only thing I put on this 
second layer is the watermark image itself. Working in Photoshop gives me total creative 
flexibility in where and how the watermark gets placed.

3) This next step is very important. BEFORE you save the Photoshop file, deselect the 
background layer. We used this layer only to set the position of the watermark. If this 
layer is not turned off, Compressor won't be able to determine what portion of the image 
is the watermark and the key won't work.

4) Create your video in Final Cut and export it as a QuickTime movie, either self-
contained or reference. The watermark is being added after your video is complete.

5) Open Compressor and import your clip.

6) Apply whatever compression settings you need for your video; compression settings 
have no impact on applying the watermark.



7) Once compression settings have been applied, go to the Inspector and click the 
Filters button. 

8) This displays a list of all the video, audio, and color filters in Compressor. By default, all 
filters are off. Scroll down inside the Video tab until you find Watermark and select it.

9) At the bottom of the Inspector, click the Browse button and select the watermark file 
that you created in step 1 above. Compressor reads Photoshop files natively. However, 
the watermark needs to be on a layer other than the background layer for Compressor to 
be able to key it into the video.

10) From the Position pop-up menu below the filter list, select where you want to poistion 
the watermark.

There are lots of locations where a watermark can be placed, depending on the 
underlying video. For this example, we'll put it in the lower right corner.

11) Next, adjust the size (Scale) and transparency (Alpha) by moving the sliders until you 
are happy with the look. In this case, I reduced the size to 80% of the original and made it 
50% opaque.



12) Here's the finished result, displayed in Compressor's Preview Window, ready for 
compression.

Adding a watermark will add time to the compression process, but since compression runs in the 
background, I can be working on other projects in Final Cut in the meantime. This saves me a ton of 
time instead of waiting for things to render.

Plus, once you have these Compressor settings created, adding a watermark is as easy as turning on 
the filter, double-checking your settings and clicking "Submit."

Very cool.
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"Gearing Down" in Final Cut Pro 



Donata Rondinelli sent in this tip:

Not sure if this was addressed in version 6 but in FCP version 5, I sometimes have a hard 
time using time remap. On very long or short clips, the keyframe always wants to snap to 
certain amounts & you cannot fine tune. With time remap, getting the right frame is 
important. I discovered if you hold down cmd while dragging the keyframe, the keyframe 
moves in small increments allowing you to get the perfect frame.

Larry replies: Using the Command key to "gear down" mouse movements is true for more than 
keyframes. You can also use it when making audio level changes, or adjusting any parameter which is 
set by moving the mouse.
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Normalizing Audio in Final Cut Pro

I've been a fan of normalizing audio for a long time, especially when the audio is really, really too soft.

Normalization means to raise the audio gain of an enitre clip such that the loudest portion of the clip 
does not exceed a level which you specify. As a note, I never normalize to 0 dB -- it's too loud. I tend to 
normalize audio between -4.5 and -6 dB.

With the release of Final Cut Pro 6, audio normalization is now a menu choice: Modify > Audio > Apply 
Normalization Gain.

However, this is not actually changing the audio itself. Rather, it is applying a Gain filter to each clip 
which raises it's level such that the loudest portion of the clip does not exceed the level you specify.



One of the benefits of the Gain filter is that, unlike all other Final Cut controls, the Gain filter can raise, or 
lower, the level of a clip 96 dB. In contrast, dragging the red rubber bands in the Timeline only allows us 
to raise the gain of a clip by up to 12 dB; which is often not enough.

With that as background, Gordon Inglis asks if he can apply normalization to more than one clip in the 
Timeline at once. So I did some checking.

The answer is yes, but with a caution.

Yes, you can normalize more than one clip at a time; in fact, you can normalize as many clips as you 
have selected in your sequence. The Gain filter will be applied with a different level for each clip such 
that the loudest portion of each clip does not exceed the level you specify in the Normalization dialog.

This is a very fast way to get all your clips to play at about the same level of loudness.

However, the Gain filter ignores any level changes you've made to your clip. So, in order to get the 
results you expect, you must make sure the audio levels for each clip are set to 0 dB.

The easiest way to do this is to select all the clips which you want to normalize, then choose Edit > 
Remove Attributes. 

Select the Levels checkbox to reset all your clip audio levels to 0 dB. 

At which point, normalization will work the way you expect.

UPDATE - Dec. 27, 2007



Wayne Kopping, from South Africa, writes:

I've automated the normalize audio process by simply creating a button for this by doing 
as follows: 

Tools > Button List > Normalize. 

Drag the Normalize Gain Button into a Button Bar on Time Line. Then it's just one click to 
normalize a clip or clips!

In fact, I encourage people to look into mapping their filters, gain, external monitoring etc. 
to buttons - it's a real time-saver!

Larry replies: Wayne, thanks for the tip. 
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Creating Multi-Color Credit Rolls

Paul Delcour writes:

I found an easier way to create a double-sided credit scroll. I use the FCP scroll text - 
prepare one with the parts - copy this on top and change the text to the actors names - I 
then change the actors names to yellow for instance - one is aligned left, the other right - I 
line both scrolls up so they leave a nice gap in the middle and hey presto! Works like a 
gem.

But as someone mentioned: if I want to add other names just single in the middle, there's 
no way of adding them. I fear it's Photoshop then of which I only have an illegal copy, so I 
do not use this for my commercial projects. Option could be to copy text from a word 
processor in Graphic Converter and use that instead of Photoshop: I just tried a bit and it 
does seem to work.

Still, it's a pain creating even relatively simple credits...

Larry replies: Paul, first, here's an article on creating multi-color credits in FCP that might help: http://
larryjordan.biz/articles/lj_credits.html

Also, if you add a name in the middle of one clip, just add an empty carriage return at the same position 
in the other credit roll to keep them in sync.

However, for credits, I prefer creating them in LiveType. Here's an article you can use to save you a lot 
of Photoshop work: http://larryjordan.biz/articles/lj_lt_text_scroll.html.

UPDATE - Dec. 27, 2007

Tom Wolsky adds:

You can also do this using Final Cut Pro's Text > Title Crawl. Complete text control, 
including guttering, though that's a little tricky.

Ben Balser writes:

CHV makes a killer and affordable ($49) plug-in that does all this and more. It's very 

http://larryjordan.biz/articles/lj_credits.html
http://larryjordan.biz/articles/lj_credits.html
http://larryjordan.biz/articles/lj_lt_text_scroll.html


flexible and I recommend it IF you're going to do this type of credit coloring in an on-going 
basis. Just FYI. Click here to learn more. 
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Finding and Replacing Transitions

Marco Fantacuzzi, from Italy, writes:

I'm Marco, and I write from Padova, Italy. I've been following your newsletter since a 
couple of years, it's a very precious tool that gave me the opportunity to learn so many 
things... Thank you!! And sorry if I always kept passively silent but I never thought I had 
something to share to other users... :-)

Last week I attended a Trainer course in Paris, where I met Victoria Parks-Murphy, very 
skillful and patient teacher: she was the first person that I ever met that could answer to 
many of my doubts and questions about our beloved FCP. She is great!! 

During the course I happen to find a nice trick that combines the use of transitions with 
the find command, and Victoria suggested me to share it with you and your readers. It 
can be a saver for editors who use a lot the overwrite or insert with transition feature, or 
for editors that for some unlucky reason are asked to remove or replace all of the 
transitions of their sequence with another one!! This is a quick way to do it (instead of 
removing them one by one):

The find command in Final Cut Pro is sensitive to transitions. Let's suppose you have a 
sequence with a series of dissolves you want to modify, or delete. You can select the 
current sequence, and hit Cmd-F, the search dialogue will appear. 

Then you insert the name, or part of the name of the transition you want to select, for 
example dissolve, or wipe, and hit Find All. All the transitions of the sequence with that 
name will be highlighted, and you'll be able to erase them in one click, hitting Delete, or 
(this is really powerful!!) replace them with another transition. 

http://www.chv-plugins.com/cms/Fx-Script/Text-collection/Text-collection.php


[In order to change all the selected transitions at once, you must use the Effects menu to 
select the new transition; use either the Video Transitions or Favorites menus. Dragging 
and dropping from the Effects tab won't work.]

I think this is one of the little magic things of FCP, that can help an editor in saving time. I 
must confess, Larry, that I'm always looking for solutions like this, not because I'm lazy, 
but because I try to take to the best the instrument that I'm working with... I think you can 
understand!! 

So, I hope you can this little trick useful, and even if you knew this already, it has been a 
good chance for me to break the silence and the 'passive reading' mode, and get to know 
you, one of my favorite teachers... 

Larry replies: Marco, I did know about this trick, but I keep forgetting it. Thanks for sending it in!

By the way, I'm also a fan of Ms. Parks-Murphy and I'm glad you think as highly of her as I do.
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Working With Large Projects

Recently, Tim Wilson wrote in asking about how to get Final Cut organized for a large project. As a 
result, Doug Rossini and Russell Stiggants both contributed ideas that I want to share with you here. 

Doug begins:

What I like to do in a big Final Cut show is break out of the Avid thinking mode and make 
use of multiple projects.

I create one big project and digitize everything into it. I then create multiple "edit" projects 
based on subject. For example I am now working on a doc about re-building a destroyed 
group of buildings in the Forbidden City. The digitize project is called "Jianfu Garden". I 
also have subject projects labeled: "Lumber", "Workers' Lives", "Views", "Stonework, 
Foundations", etc. I copy all relevant clips from Jianfu Gardens to the correct edit project. 
See the the first image below.



The next step is to create a project called "Selects". In the Selects project I create 
sequences that correspond to the Edit projects, i.e, Lumber-selects, Workers LIves-
selects, etc. I make selects, and string them on the relevant sequences. As I am editing 
the piece I open the relevant edit sequences and use them as select rolls (like in the film 
days). See the second image below.



Most of the time I only need to have the Selects project open. If I need to dig deeper into 
the footage, I can open any of the subject projects.

Then, Russell sent this in:

I don't envy Tim Wilson with his massive project. I've just completed an FCP edit of (a 
final) 33 minutes - but which was cut from several tens of hours of vision. We went 
through the same process as Tim, trying to figure out how to keep a handle on all our 
material and being able to assemble the whole thing into a single timeline.

We did what Tim is doing - placing vision/audio assets for a particular sequence into bins 
then doing a rough-cut for 'feel', keeping that timeline in the same bin.

We found though, as no doubt Tim is finding, that we ended up going 'loopy' just trying to 
keep track of the assets, the cuts and the bins -- "....was that shot in bin X or Bin Y.... or in 
sequence A or B....?" was a question we increasingly asked ourselves.

We also grappled with an ever-increasing 'master' timeline, which as you mentioned can 
slow FCP down considerably.

In the end, we did this:



Wherever possible, we worked 'linearly'; that is we worked on the 'opener', then the next, 
say, 2 minutes, which we would call - "Chapter One - tuna fishing", followed by "Chapter 
Two - sharks", then "Chapter Three - Mulloway" and so on and so on. You get the idea. 
By using a book-like index, we were able to identify sequences either by number, or by 
subject. Of course, we kept a brief written log of our chapters/titles so when our brains 
froze at the end of a long session, we could always refer to something on paper, rather 
than the mush between our ears.

When we had two or three chapters largely to our liking came the issue of the long 
timeline. 

We solved it this way: From our rough-cut assembly in Chapter One, we would export the 
timeline to a Quicktime movie. Then we would do the same with the rough-cut of Chapter 
Two, Three, Four and so on.

We brought these mini-movies back into their own Bin, then placed them in a timeline we 
called "Rough_Cut_Master_1".

This had the advantage that each 'Chapter' could be viewed relative to the next chapter 
and be compared with the one preceding it. This gave us a great 'feel' for the way the edit 
was going, comparing time and pace and the million and one other things that makes for 
a good finished cut. Where we found flaws, we would go back to our 'Chapter' edit, make 
the necessary changes, output it again to a QT movie, re-import it, replace the old 
chapter sequence in our Master timeline with the new, and go through the comparison 
again. It might sound a bit tedious, but after a while, we really got into the swing of it and 
it saved us heaps of time and heart ache.

We got so good in the end that we would work out whether we would dissolve and/or 
'effect' into or out of each Chapter, and how we would treat an audio transition into/out of 
the chapters. This meant that we were able to build the final edit in this manner (this may 
not be possible for Tim, but it worked for us).

Looking back, there's one other thing I would recommend, particularly as Tim's project will 
be substantially bigger than ours:

Tim is likely to end up with substantial numbers of bins, or 'chapters'. To keep track of 
them all (once Bin A for example is established and contains assets and a timeline) I 
would use that excellent Apple Utility GRAB (Applications>Utilities>Grab) and capture a 
'screen dump' of each Bin (in Grab, you have the ability to capture a 'selection' which you 
nominate by click-and-drag - you don't need to capture the entire screen). I would then 
print that out (import to Word if you like and append other text to it) - and placed it in a 
ring-binder. Voila! You have an ongoing record of your bins which you can refer to when 
the brain dies! A great help! You could also create a file in a data-base program for each 
Bin (even in Excel!) which could be searched by keyword - but that would take more time 
and may or may not be practicable.

Anyway, I hope this helps.....

Larry replies: Thanks to both Doug and Russell for sharing their ideas.
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A Faster Way to Record

Claes Jonasson, of Film & Company, LLC, writes:

I used to record live training sessions, with a quick turnaround to finished DVDs. To cut 



  
  
  

out the time spent capturing the footage off tape, I brought my PowerBook and a hard 
drive with me to the shoot and fed the firewire DV signal into the laptop. Then I used the 
capture now in Final Cut to capture the live video (not forgetting to make sure I had no 
maximum length set to capture now). 

That meant that as soon as I was done, I could do the minimal editing (the hard drive with 
the footage could just be moved to my desktop computer) and be done. In my case, I ran 
3 cameras through a DV switcher and also included audio from an audio board.

Frequently I would also do a backup recording to tape or DVD of the signal that the 
computer was recording, just in case something bad would happen.

Doing it this way saved on equipment, and allowed me to provide finished programs later 
the same day, or the next day.

Larry replies: While I do not, as a rule, recommend using Final Cut for live capture because if you lose 
that file on hard disk, you've lost everything; still, you have an interesting method which I am happy to 
share.

Claes then sent this:

I understand why you might not want to recommend as a general practice to record to 
disk through Final Cut, which is also why I would normally do a safety recording on tape.

You might be interested to know that at the church I attend and where I am part of the 
video team, we record the sermon live and transmit it to 3 other sites, each with a 
different delay (in the range of 2-5 minutes). Our setup is all Mac-based, with xRAID at 
the center. We record on one Mac (can't think of the software we use for that--the same 
software is used by broadcasters for delaying/editing live events) and write the files to the 
xRAID. Then 3 other Macs are used for playback of that file, chasing about 10 seconds 
behind. When the message starts, each of those Macs, using Final Cut, gets cued to the 
starting point, and we edit in a bumper. Then when a site is ready to go, we use print to 
video to send the message to them. This system has been in use for a couple years now 
every Sunday and works quite well. Only on rare occasions do we have dropped frames.

Larry replies: Very cool. Thanks. 
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Picking the Right Hardware

Probably the question I get asked the most is "what hardware should I buy," or its close cousin, "What's 
the best hardware."

For instance, Dave Johnston wrote:

I am in a position right now to very possibly set-up my long dreamed of professional 
editing & production suite. This will be pretty much of a one-person operation.

Two questions.

1. With limited funding, what would be the components of your ideal production set-up? 
[specific software, hardware, etc.]

2. If you had unlimited funding, what would you want to have? 
[components of core system and possible future expansion as skills improve]



  
  
  
  
  
  
  

I am hoping to work primarily with MiniDV and move into some HDV. Your courses and 
EDIT WELL have been quite useful as I study the whole scene, and now I may actually 
be ready to "launch." I have become disabled and now have a lot more time at home, I 
hope to make that time productive!

Larry replies: There is no perfect video solution. It depends upon the market you want to serve, how you 
intend to distribute, the size of your final image (projected images require higher quality than images 
that end up on the web), and your demands for editing speed, turn-around time, and system cost.

You also didn't indicate if you wanted an HD or SD solution - choices are far more varied with HD.

Given all these different parameters, if you want absolute low-cost, HDV is the choice, however, the 
quality is not particularly high, and you have lots of issues in timecode and color accuracy. As well, it 
takes a long-time to output.

The DVCPRO HD (Panasonic P2) system is good, more expensive than HDV, but faster and higher 
image quality.

Unlimited funding, without an understanding of your plans for distribution, is impossible to answer. If you 
are shooting the next George Lucas feature film, you need a Sony F23 1080p camera - or a Red 
camera. That would require two striped RAID-50's, and probably a fully-loaded Mac Pro.

My suspicion is that your needs are a bit more modest.

The key is to determine WHY you are getting in HD in the first place. Then, look at how you want to 
distribute your HD material. Is it being projected to an 80-foot screen or only displayed on the web? How 
important is image quality versus camera size? Are their requirements from your distributor?

In general, when you are working in HD, you work backwards. The distribution media determines what 
format you need to output. Output format generally determines the format of your sequence. And your 
sequence format determines what format you'll convert all your footage into. In other words, distribution 
determines the workflow.

[ Go to Top. ] 

Editing HDV

I have been somewhat vocal in discussing some of the problems in working with HDV. However, there 
are lots of different opinions on this point. Recently, Iain Anderson gave me permission to reprint this:

I heartily recommend editing HDV footage natively. A number of people have expressed 
the opinion that long-GOP MPEG footage is inherently hard to work with. It's not -- it's 
very much the same as editing with DV, and Unlimited RT works just as well. You 
certainly don't need to render every edit.

I recently cut a short film in HDV on a MacBook Pro, and it was a painless experience 
which produced high quality results. I used FCP6, which did make the process somewhat 
easier. As the film was part of the 48 Hour Film Project, I had less than a day for editing 
and delivery to mini DV tape. A shame to see all the HD quality disappear at the end, but 
the process worked well.

The advantages of HDV:

1. No extra hardware needed to import footage. Any machine capable of running the 

http://www.peachpit.com/promotions/promotion.aspx?promo=135721


current version of Final Cut Pro can cut HDV. It's painless to edit, and while effects can 
take time to render, the vast majority of effects work with Unlimited RT just like SD 
footage. The only issue I had with rendering was when overlaying several streams of 
video with feathered cropping.

2. No transcoding needed. You can't get better quality by recompressing. In fact, you can 
make it much worse. DVCPRO HD, for NTSC frame rates, uses a different frame size 
(1280x1080) to HDV (1440x1080). If you have to transcode, ProRes 422 or AIC are 
better choices.

3. Low data rate. It's HD with the DV space/data rate requirements of ~13GB an hour, 
while transcoding at least triples your data rate and space requirements. We've just about 
hit the point where you'll be able to keep all the HDV you ever shoot permanently online 
by buying a cheap hard drive every few years.

4. Easier media management. When you capture HDV natively, footage is automatically 
split into separate files based on when you started each recording session. No more huge 
files from students capturing files in hour-long blocks and easy deletion of bad footage.

5. Near-instant HD screeners. HDV footage needs no recompression to go onto an 
HDDVD, and every current Mac can play HD-DVD's made with DVD Studio Pro burnt to 
regular DVD discs. This is incredibly powerful; it's about the only way to deliver HD 
footage without expensive hardware. You will need to conform HDV footage to do this, 
however, bringing us to...

The drawbacks of HDV:

1. The 4:2:0 colors. Not ideal, but the same as PAL DV. If you've shot in HDV, the 
damage has already been done, but it's really not that bad. The latest Sony XDCAM EX 
uses the same colour space. This doesn't have to limit the quality of your colour 
correction, though -- see 3 below.

2. Long conform times when finished. This is an issue only when you've finished your edit 
and need to export back to HDV. The conforming process takes about as long as a slow 
render, say, a few times real time. If you're not finishing to HDV, not a problem. While 
you're editing, not a problem.

3. Recompressing to HDV can introduce artifacts and is slow. True if you're colour 
correcting or applying other filters, but there's a fantastic solution built in to FCP 6. 
Choose Sequence Settings, and look under the Render Control tab. Change the render 
codec to Apple ProRes 422. Specifically for HDV and XDCAM HD/EX, this feature 
renders effects to ProRes instead of HDV. No quality loss, no extra time spent 
recompressing during editing.

For Larry Jordan's (slightly differing) opinion, click here. 

But don't miss Graeme Nattress's comment on Larry's page:

[Should you convert HDV to DVCPro HD?] No. Never! Why? Adding 
compression on top of compression is just bad. DVCproHD is way too 
compressed. It's full of artifacts even straight of a varicam. To add that 
compression on top of HDV just makes a mess.

Answer - edit HDV native - it's easy on a decent mac, and then just change 
the compression right at the end of editing to "uncompressed", do a final 
render before going out to master tape. Again, you'd never use HDV as a 
master - even one compression back to HDV looks awful.

Only use DVCproHD if that's what you shot, or are going back to 
DVCProHD tape. If you're recording live from SDI, uncompressed HD, or 

http://www.larryjordan.biz/articles/lj_hdv_learn.html


Photo JPEG 75%, are much superior.

HDV isn't perfect, but I'm constantly amazed by the quality I get out of my HV 20 for the 
price and how easy it is to deal with. It's possible that the poor opinion of HDV PQ in the 
industry is partly due to the PAL/NTSC divide. Here in Australia, we only have to record 
25 frames per second at the same data rate that NTSC models have to record 30 frames. 
Those 20% extra frames per second might be pushing the compression just a bit too far.

Larry replies: Thanks, Iain, for allowing me to share this.

[ Go to Top. ] 

QuickTime Format Converter

Someone recently referred me to Votaic - a video format converter.

I have not used this, but for those of you who need to convert HD footage, this may be worth checking 
into. Here's their website: http://www.mac1080hd.com/

If you try this, let me know what you think of this product.

UPDATE - Dec. 27, 2007

Tom Wolsky adds:

The downside of this software, is that it requires the Perian QuickTime plugin, which 
unfortunately breaks some capture functions in QT 7.3 and may cause the application to 
freeze and crash.

[ Go to Top. ] 

Edit Share Supports Final Cut Project Sharing

This announcement is a little old, but I am WAY behind in catching up on email, so I want to share it 
now before it gets any older.

If you are in a networked environment and need to have multiple editors working in the same project file, 
you should check into Edit Share.

Here's the press release that spurs this suggestion.

[ Go to Top. ] 

Comments About Final Cut Pro's Video Scopes

Recently, I had a conversation with Alexis Van Hurkman as we were working on a series of articles 
about Color for Edit Well.

http://www.mac1080hd.com/
http://www.editshare.com/
http://www.editshare.com/index.php?option=com_content&task=view&id=169&Itemid=119
http://www.peachpit.com/promotions/promotion.aspx?promo=135721&redir=1


[ If you haven't been reading Edit Well recently, Alexis' multi-part series on Color is 
incredible. It began in Volume 1, Issue 12 and has continued for the last six issues. ]

Starting with version 5.1.2, Apple improved their video scopes, so I asked Alexis whether they were now 
"good enough..." Here is Alexis' reply: 

First, the FCP scopes at this point do show super-black, down to –10 percent digital 
(although it's true that they didn't used to). You'll probably have to crank up the scope 
graph intensity to see the kind of detail down that far because unless the camera operator 
has tweaked the camera pedestal the only superblack pixels that get recorded are noise 
from the imaging chip (to increase video scope graph intensity, click the little button at the 
upper left of the window and drag the slider to the left). The default graph intensity is a 
little faint, but all the signal details are there.

Second, super-black levels in FCP get clipped as soon as you add a Broadcast Safe filter 
to them. For more details about super-black levels, you can reference my "Encyclopedia 
of Color Correction."

Third, the Color scopes show super-black as well, down to –20 percent digital, and the 
default Broadcast Safe settings clip these levels so long as they're activated (in the 
Project Settings tab of the Setup room). However, whereas the FCP scopes now analyze 
every single line of the image (so long as the playhead is paused), the Color scopes 
analyze the image by scaling the image down internally and analyzing a reduced frame 
version of the image (I put more details about this in the scopes chapter of the Color User 
Manual). Because of the math involved, every pixel of the scaled image does contribute 
to Color's final analysis (unlike FCP's old method of skipping lines completely, which is 
now only used when FCP's scopes analyze during playback), and as a result the Color 
scopes analysis very closely approximates that of a set of external hardware scopes. 

However, I generally tell folks that while the Color software scopes are great for making 
creative decisions, for true QC work you really should have a dedicated video scope 
that's monitoring the output of your broadcast video output card. The reason for this is 
that even though Color's legalizer (in 1.0.1 and now 1.0.2) is very accurate and the Color 
scopes are very clear, depending on the particular combination of contrast, color, and 
subjects in any given image, various mathematically complex things can happen to the 
video signal when it goes through the encoding hardware of your video card which may 
produce occasional unexpected transient levels above where they're supposed to be. If 
you're not looking at the output of your video card, you're not seeing the whole story (for 
the purposes of quality control).

Lastly, I recently did a training DVD-ROM if you're interested, for Magnet Media. I'm very 
happy with how it came out, and I've been getting a lot of positive feedback from folks 
who've picked it up. Click here to learn more about it. 

Larry replies: There are very few people who know more about Color than Alexis. I'm grateful for his 
comments.

[ Go to Top. ] 

Edit Well Interview Guests Needed

If you are doing something interesting with Final Cut Pro, I'd like to interview you for Edit Well.

Each month, in every issue of Edit Well, thousands of editors get tips and techniques and tutorials they 
can't get anywhere else.

Part of each issue are interviews with Final Cut Editors on how they are using Final Cut, the challenges 

http://www.peachpit.com/promotions/promotion.aspx?promo=135736
http://www.digitalmediatraining.com/products/jumpstart/fcstudio2/color/index.html
http://www.peachpit.com/promotions/promotion.aspx?promo=135721&redir=1
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they face, the projects they work on, and how they are using Final Cut.

Recent guests include:

�●     Eddie Kilgallon - Editing Montgomery Gentry videos on the bus
�●     Steve Olswant - Editing Dan Rather Reports
�●     Ryan Mast - Teaching FCP to junior high kids
�●     Shane Ross - Editing for the History Channel
�●     David Jolosky - Creating effects-driving projects
�●     Sabrina Nelson - Teaching FCP to college students

I'd love to talk to you, too. Just send me an email with a quick description about what you are doing.

Thanks!

[ Go to Top. ] 

Reader Mail

Audio Needs to Render

Conrad recently wrote:

I'm finding a majority of movies I import/add to a sequence timeline are requesting 
rendering. Often it's just the audio that gets the redline above it in the timeline and will not 
playback in the canvas or timeline. Easy Setup takes care of a small percentage (in a 
new sequence after selecting easy setup), but most not.

I'm an audio guy- the project is basic audio post, I'll export to pro tools 
or logic or perhaps roundtrip it to soundtrack- but it's been hard to organize my workflow 
with this going on. I'd rather not reprocess the audio before doing my post, which with my 
limited conceptual understanding of FCP is what it appears to need.

Larry replies: Conrad, thanks for writing. While FCP will handle 44K and 48K audio on the same 
timeline, three things will cause rendering:

1.  Having more than 8 tracks of audio (this can be changed in the Final Cut Pro > User 
Preferences > General tab)

2.  Mixing 32K and 44/48K audio in the same timeline\
3.  Using an audio format that isn't 44/48K

Hope this helps.

[ Go to Top. ] 

Positioning Text

Jonathan Kirsch writes:

I was going over your editing library tips about "Improving the Look of Your Graphics and 
Text" in FCP and couldn't find something I thought was there. I keep forgetting whether its 
better to position text on even or odd lines (Y values). For some reason I can't tell which 
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looks better with the text I am working with (Helvetica Condensed Bold). Any way you can 
help me remember?

Larry replies: Positioning text is less important than point size. Try to keep your text in even whole point 
sizes, when working with fonts smaller than about 30 points.

However, if you are compositing two or more pieces of video and both were shot interlaced AND both 
are scaled at 100%, then it is critical that all images have their vertical position be an even whole 
number (the right-hand box of the Center parameter in the Motion tab.)

Otherwise, the interlacing between the different layers interferes with image quality and all your 
foreground images will look blurry or soft.

UPDATE - Dec. 27, 2007

Tom Wolsky adds: 

Do not use the Motion tab to position text. It will display better if you position it using the 
origin or position functions in the Controls tab. It is also important if you are animating text 
position or other parameters to animate it in the text's Control tab and not in its Motion tab.

Larry replies: Tom, I agree. Text should always be sized, positioned and animated using the Controls 
tab, as that retains the vector nature of the text, providing extremely high quality glyphs. Sizing and 
positioning in the Motion tab always moves the frame that contains the text, not the text itself and scales 
the bitmap of the text, which is not the same quality. 

[ Go to Top. ] 

Capture Magic vs. VeeScope Live

Ben Balser sends in the following:

Just to comment on the CaptureMagic solution. For half that price, you can get VeeScope 
Live, and not be limited to only two cameras. Plus it has some other advantages such as 
overlay comparison, color scope overlays, and some killer green screen tools.

If you need clip management, HD (or DV) Monitor Pro has unmatched clip management 
that allows more info to be associated with each clip, and will take all that directly into 
your FCP project with one mouse click.

http://www.bigmugsoftware.com/capturesd/
http://www.dvdxdv.com/NewFolderLookSite/VeeScope/Products/VeescopeLive.overview.htm
http://www.dvdxdv.com/NewFolderLookSite/VeeScope/Products/VeescopeLive.overview.htm


My review of these can be found here- 
http://www.eventdv.net/Articles/ReadArticle.aspx?ArticleID=38083

I'm playing around with CaptureMagic HD at the moment, and like it very much. Although 
I don't like the messy multi-window interface (my biggest gripe about ScopeBox) and the 
limit of only two cameras. Aside from that, it's a nice app to join in the competition with 
VeeScope and Monitor Pro.

Larry replies: Ben, thanks for letting us know.

[ Go to Top. ] 

Shooting 24 FPS

Andrew Wilson, of Westview Digital Video and Design, writes:

[Regarding your comments a couple of months ago ] I completely agree with your opinion 
on shooting 24p 'because someone told you it looks better'. Go buy a filter and do better 
lighting. Right on!

One question, since 99% of my production work is seen on SD TV's, I still use all SD 
settings and shoot with an XL2. The only reason I would think of upgrading now to HD is 
to future-proof my productions (I've been thinking of Panasonic's P2 500 camera).

I hear a lot about the different standards of HD; 720p vs 1080i vs 1080p but I can't think 
of what the proposed frame rates are of those standards. So I agree with you about 
shooting in the format that most people are watching but what are your thoughts on 
shooting in HD to future proof your footage - and what settings do you think will do the 
best job at that?

Larry replies: Shooting in HD to "future-proof" your productions is a good idea -- provided your content 
will still be relevant a year or two in the future. 

As for which is the "best" format, my first recommendation is to shoot progressive, rather than 
interlaced. After that, 1080 may be better, but there are many outlets that only take 720 material. 
Assume that whatever you shoot is going to need conversion into a final format for distribution.

Currently, HD video is somewhat of a mess.

Andrew then wrote back:

That mess is what's saving me $20k on a new camera. I can wait. However, are *most* of 
the HD standards going to be 24 fps? What are the proposed frame rates of the various 
HD formats?

Larry replies: Currently, HD supports, and actively shoots, 23.98, 24, 25, 29.97, 59.94, and 60 fps. Pick 
something you like.

Keep in mind that the experts tell me that there is no easy way to convert between frame rates for North 
America and the rest of the world. If quality and speed are most important, plan to take your project to a 
facility and have this conversion done using hardware - most often, a Teranex box.

If price is most important, using Compressor or Graeme Nattress' Standard Converter are good options.

http://www.eventdv.net/Articles/ReadArticle.aspx?ArticleID=38083
http://www.teranex.com/
http://www.nattress.com/
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Scaling in Compressor

Lee Berger sent in the following comment on down-converting images in Compressor:

I would add that Compressor is an excellent software alternative. I'm very disappointed in 
FCP's ability to downscale in a sequence (placing HDV clips in a SD timeline). I've found 
that no matter what sequence or render codec I choose the aliasing is unacceptable 
(even after rendering). 

My workaround is to use Compressor to downscale clips or a sequence (via a self 
contained in native format). I have created a setting for HDV to SD with letterbox. You 
can clearly see the difference in quality between the two workflows (look at the brim of his 
hat). 

Oh yeah, I also tried field dominance and field shift with no change in the result

Larry replies: Lee, thanks for sending these in. The images above are scaled-down JPEGs of the PNGs 
you sent in. If you want to see the original PNGs, side-by-side, click here.

[ Go to Top. ] 

Solving Compressor Problems

Here's an Apple Knowledge Base article that can help with Compressor trouble-shooting

[ Go to Top. ] 

Up-resing SD Clips

Thinking about HD, Wayne Wright writes:

We are shooting an HDV program, but have 2 or 3 really useful clips in DV format that we 

http://www.larryjordan.biz/assets/nxltr41/Berger-source.tif
http://docs.info.apple.com/article.html?artnum=302845


will need to use on the HDV timeline to fit the story. I have not tested it yet but will these 
DV clips look degraded after import? I realize they won’t look better but hope they will still 
look acceptable. I will do final output to SD DVD.

Larry replies: Any time you resize an image to be greater than 100% in size, you are likely to degrade 
the quality because you are stretching pixels to fill an image size greater than the original source.

Whether the image quality is acceptable to you depends upon your definition of quality, how important 
the shot is, and the overall look of the show. 

For me, I try really, really hard not to zoom too far into my images; not more than about 105%.

[ Go to Top. ] 

Smooth Moves on Stills

Wow! Nothing has generated comments like this next question. Thanks, everyone, for sharing your 
thoughts. 

Steve Heffner, from NY, writes:

I am working on a project that has a lot of motion on photos (luckily, basic push ins). We 
don't want the motion to come to an abrupt stop. We want a smooth braking of the push 
in. 

The problem seems to be that if we use (on a keyframe) "EASE IN/EASE OUT" in the 
canvas or "SMOOTH" in the motion tab viewer, we are getting an unsatisfactory result 
(the image seems to do an additional, albeit slight, side to side or up and down 
movement). I've tried many adjustments and can't get a successful (what should be 
simple!) result. 

Any suggestions? We just want a nice, smooth landing into the resting point of the push 
in on the graphic/photo. 

Oddly, the EASE IN/EASE OUT works great in FCP if you are doing a direct push or pull. 
Once you change the center point (say to focus on a single subject on the push in), FCP 
gives the photo a "sway" before it stops. ANNOYING.

Larry replies: This has been a long-time problem with Final Cut. I spent some time on the Web looking 
for a good third-party filter that smoothes out working with stills in Final Cut, but couldn't find anything. 
So, I asked our readers for help. 

UPDATE - Dec. 27, 2007 

Lee Berger writes:

As it's included in FCS I recommend Motion for moving stills. Motion's timeline makes it 
much easier to set the key frame interpolation and doesn't produce unwanted 
movements. The only drawback to Motion is its 2K pixel limitation. I also use Boris Red (I 
believe it can handle up to 10K pixels). Boris FX and Graffiti can also do this animation. 
After Effects also has excellent ease in and ease out interpolation and can handle even 
larger pixel resolutions. Finally there is are plugins from Stage Tools "Moving Picture" and 
"Moving Parts," but I haven't tried them. Visit http://www.stagetools.com/ 

Michael Scott adds:

http://www.stagetools.com/


Maybe sending to Motion is a way to solve the problem with final cut pro rendering funny 
smooth moves, also opening the final cut pro keyframes into motion might also be a way 
to refine more. 

The other thing to remember is to set Render Motion Projects at Best in Sequence > 
Settings > Render settings tab. 

Finally, adding a little motion blur in the Motion tab could help out but then rendering 
takes ages 

Tom Wolsky adds:

CGM's Roll/Scroll Title plugin works very well for this. One of the best things about this is 
that it allows you to move an image to a certain point, hold, and then move it again, which 
you simply cannot do properly in FCP. Lyric's PanZoom plugin is good too. There are also 
standalone applications like Moving Picture and Photo2Movie (I think they're called) that 
work quite well. 

Loren Miller sent this:

I find MovingPicture to be a stable, mature product with a friendly interface, at least in 5.x 
and earlier. StageTools.com, the vendor, generally keeps its products up to date. 

MP comes as a plugin "filter" or standalone "producer" version, which allows a bit more 
power. The only curve ball is the extra charge for the "Rotation Tool"-- but this has the 
added function of being able to skew the "platen" of the image in 3D space, as well as 
spin it in 2D.

The workflow is a little odd, in that you must filtrate a clip you select in the timeline as a 
placeholder. To make this practical, I often title a color matt clip "photo of..." and I can 
actually rough in the pacing of the clip prior to loading a rich scan photo and animating 
inside MovingPicture. You don't have to; any clip can work as a placeholder; I think even 
Slug will work. The original image content is removed when the animation is rendered.

You apply the filter, then open the filter controls pane to get the photomotion stage. Here, 
you load a photo scan, and it's very straightforward and you can control eases 
predictably. Also, it's got a rendering engine which allows 8000 pixels square-- I suspect 
more than FCP's native Quicktime graphic import-- although the newest dimensions are 
not known to me (even after some digging). MP allows you to take in a very rich scan-- 
which of course supports really close zoom-ins which don't go soft -- and a simple ease in/
out checkbox, and as I recall, the acceleration/deceleration can be numerically tweaked 
as desired. Creating intermediate holds are a snap. Just duplicate a keyframe. We are 
currently nowhere near this elegance in FCP photo keyframing.

There are other third party solutions, (PhotoMagico, Still Life, even Motion is cool for 
photomotion) but MP allows you to stay inside FCP. The only time cost is rendering the 
animation clip, once you step out of the stage and back into the timeline. Another 
advantage is, you don't lug around a keyframed rich scan-- it's been made into a 
rendered movie, and MP supports 32-bit subpixel rendering for smooth moves. The 
original photo is part of a proprietary MP file you save to hard disk. 

Cal Deal adds:

I bought Pan & Zoom to deal with the Ken Burns effect in Final Cut. Tried it once, found it 
cumbersome, but never gave it a fair shot because I was too busy at the time. So maybe 
it will work. I definitely want to experiment with it and will be very happy if it does work.

Here's a tutorial: http://www.studiodaily.com/studiomonthly/tutorials/trainup/8371.html

http://www.stagetools.com/
http://www.studiodaily.com/studiomonthly/tutorials/trainup/8371.html


Another wonderful program is Photo to Movie. Easy to use, nice smooth pans. But you 
have to export the movie and pull it into Final Cut in order to use it. I prefer a more direct 
route.

See http://www.lqgraphics.com/software/phototomovie.php 

Robert Sink writes:

For smooth moves on stills I have been using Pan Zoom Pro, a FCP plugin from Lyric 
Media, and it's the best I've found so far. 

Read more here: http://www.lyric.com/fcp-plugins/panzoompro/pzp.htm 

Stuart Math chimed in:

The problem he is seeing one I’ve struggled with for awhile – it is the result of an s-
shaped motion path that is generated by the ease-in ease-out keyframes. As Steve 
noted, it is more obvious in certain situations than in others. 

Boris FX has a new filter in their Boris Continuum Complete (BCC) filter collection called 
“Pan and Zoom” that may help him. A trial copy of BCC can be downloaded from the 
Boris website. There is a BCC version for AE and a version for FCP. Go to: http://www.
borisfx.com/downloads/ for a trial download.

Each comp is going to be a little different and he will have to experiment to find the right 
workflow for him. The Boris “Pan and Zoom” filter has a lot of power and it has a learning 
curve, but it is worth it if he does a lot of this work and wants more control.

Buddy Englett provided another solution:

What I do is place the keyframes beyond the In & Out points of my image. Like so:

1.  Place the image in the Timeline
2.  Double-click the image to open it in the Viewer
3.  Click the Motion tab in the Viewer
4.  Press Shift > i to go to the In point of the Image, then press Shift > Left Arrow to 

move one second before
5.  Press Control > K to add a keyframe 
6.  Press Shift > O to go to the Out point of the Image, then press Shift > Right 

Arrow to move one second after
7.  Press Control > K to add a keyframe
8.  Make your adjustments on these keyframes and you'll have smooth movements 

coming and going

Larry replies: I'm floored by the response to this question. Thanks, everyone, for sending comments! 

[ Go to Top. ] 

Problems Burning DVDs

Johnathan Edghill Prada, from Caracas, Venezuela, writes:

I have a problem burning final DVDs from DVD Studio Pro. My projects looks fine in the 
simulate windows and it burn fine to the disk but when I play it in the DVD player (both in 
my computer or in the home player) the DVDs "freeze" around 05:30. Sometimes is 6:15, 
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sometimes 5:30. 

I was thinking that it was a bit-rate issue but changing it does not seem to fix anything. 

Can you tell me where to get assistance in this issue.

Larry replies: Johnathan, thanks for writing. Since you have already tried changing disks and burning in 
both Toast and DVD Studio Pro, In spite of your guess, I stil think the problem is actually with your 
compression bit-rates. You probably didn't change your bit rates enough.

The clue for me was that your DVDs were freezing in about the same spot each time, even when you've 
burned multiple times to multiple disks.

Although video can be compressed in a variety of settings, faster bit rates are not better. What happens 
is that there's so much data coming off the DVD that the set-top box or the computer can't handle it and 
things freeze.

For my SD DVDs, I set my bit rates to an average rate of 5.5 mbps and a maximum bit rate of 7.2. Then, 
if I need to squeeze on more video, I lower the average rate, but don't touch the maximum rate. 

My guess is that your bit-rates are close to the 9 mbps rate, which is too much for most equipment.

UPDATE - Dec. 27, 2007

Jeff Coleman writes:

This may not be a bit rate issue. I started this thread awhile back and haven't gotten to 
the bottom of it either. I think it's a DVDSP 4.2 on an Intel Mac vs. DVDSP 4.1 thing and 
not a bit-rate thing as I'm using the same mpeg file for both compiles. You can read it 
here. 

[ Go to Top. ] 

Finding the Project File

Sam Shirakawa writes:

I am trying to send a project file in MOTION 3 to a friend who wants to take a look at it. I 
have no idea where or how to access the PROJECT FILE, nor how to prepare it to send 
per email. Could you please direct me to a step by step on this? 

Larry replies: Sam, this is easy.

A Motion project file is created whenever you select File > Save (or Save As). It's the instructions you 
save on your hard disk that tell Motion how to create an effect.

These files are very small, which makes them easy to email. 

All you need to do is create your effect in Motion, save the file someplace where you can find it again 
when you exit Motion. Then, launch your email program and locate that Motion file (also called a Motion 
project). Attach the file and send it to your client.

In order for them to view it they will need the same version of Motion you used to create the file.

http://forums.creativecow.net/thread/155/868099
http://forums.creativecow.net/thread/155/868099


[ Go to Top. ] 

Changing Video Background Colors

Jennifer Reinish, from Santa Barbara, writes:

I am working on a corporate project, and they have many graphics they have given me. 
But, they want the background on some of the images to be black (the default) and others 
they would like on a white background. I tried to switch a few images to a white 
background, and it changed the entire project to a white background. Is there a way, 
without taking each image into photoshop to matte it, to put part of the project on a white 
background? I can't stretch the images to cover the entire screen, as I'd then lose some 
lettering/images on certain screens, I think.

Larry replies: Jennifer, Final Cut's timeline background is always black. 

When you change the color in the pop-up menu in the Viewer or the Canvas, you are not changing Final 
Cut's background, you are simply changing the display background for the Viewer or the Canvas 
window itself. 

Changing the background for a window makes it easier to see, say, black text, which would be invisible 
in a black window. Or transparency in an image, when it is set over a checkerboard.
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Voice-Over Tool Question

Charlie Wilson, of the BBC-Washington, writes:

I use the voice over tool since our mikes are not on the digital router. Every edit room has 
the same problem with it "seeing" the correct input. With "built-in line input" selected, it 
takes several toggles to other inputs and back before it shows audio coming in. Is this a 
known bug or is it just me?



Larry replies: Charlie, I don't know. Let me see if our readers have any ideas.

UPDATE - Dec. 27, 2007

Jeff Coleman sent this comment in:

Best I can tell this has always been a problem for me on several different macs using 
different USB input devices or even KONA devices. It's never been click the source and 
it's there every time. 

Bill Darst added:

When the VO is selected, the VO box will bring every possible audio connection you have 
going into your Mac. After trying to force feed it through Multibridge Pro, and Audio line in, 
and just before getting up to take a trip to the ocean, I thought just for laughs I would 
select my USB connection to my Logitech headset mic. That way I'd know that didn't work 
either. 

Whoa! The audio meter was pegging off the walls. USB, what a thought. Bought an $80 
XLR to USB cable, went into System Preferences and selected "Unknown USB" as my 
input, and Poof. There it was. It shows up in the VO box as Unknown USB, that and my 
borrowed $1,800 Sure mic sounded wonderful. All you have to do is select your target 
audio track on your sequence, set an in point for the play head to start, and it works just 
fine. If you aren't sure about your first take, it will automatically start exactly the same 
place one track below for your second take. 
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Audio Scrubbing

PF Bentley, from Kailua-Kona, Hawai'i, writes:

I have a quick and I hope simple question - when I'm working with my MacPro and I scroll 
the playhead in the timeline on the audio track, I can hear the audio as I scroll which 
helps in editing as you know.

The audio is silent when I work on my MacBook Pro and I do the same thing. Is there a 
setting that needs to be set that I'm not doing on the laptop? I have 4GB of RAM.

Larry replies: Audio scrubbing is controlled from the View menu. If Audio Scrubbing is checked, you'll be 
able to hear your audio as the playhead is dragged hither and yon in the Timeline. Otherwise, the 
Timeline will be silent.

[ Go to Top. ] 

Problems with Tapes?

Joan York writes:

I took your advice and got the Sony PD 170 after having problems with my Sony VX2000. 
I kept getting the yellow clean cassette flashing (of course I used my cleaning tape) and it 
would happen again. I would have a major drop out in the tape and my audio was out of 



sync, and thought that it was my head going. It is an older camera.

I sent it to a Sony dealer to have it fixed (almost $600.00) and there was nothing wrong 
but obviously had a good cleaning. I got it back and it happened again and again. I 
thought I was going CRAZY. So I sent it back to get repaired again. In the meantime I had 
to get something reliable because these things can't happen at a wedding and bought the 
PD 170. I used it once and it was okay. The second time I had the yellow flash again. 

Holly mackerel!!! 

I then started to think it was the tapes. I am using the Panasonic AMQ's. When I think of 
it, it wasn't long after that I changed tapes that I started to have the problem. I then got in 
touch with Tape Resources that is my supplier and ordered the older panasonic PQ's 
because the MQ's were discontinued. I shot with them the next wedding and didn't have a 
problem...

I have been talking with the Panasonic rep. I will be sending him the tapes I've had 
problems with for inspection. Have you heard this from anyone else. Computer problems, 
camera problems. I am getting kind of tired...

Larry: It is never a good idea to keep switching between brands of tapes. Pick a brand you like and stay 
with it. Your camera works more reliably that way. However, if anyone has had problems with these 
tapes, let me know.

UPDATE - Dec. 27, 2007

Ben Balser adds:

Absolutely, I've found I always have trouble when I mix Panasonic and Sony tapes on the 
same camera. 
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Chroma-Keying

James Moriarty, from Indianapolis, writes:

I work in FCP every day, and I've been fighting the chroma-key problems with mini-dv for 
about two years. I have a client who wants to shoot chroma-key for Flash production. 
Your article at http://www.larryjordan.biz/articles/lj_compress.html helped me prove to my 
video producer friends that I'm not crazy and that the compression is the problem, but I 
still need to film chroma-key with MiniDV. 

I've read and tried suggestions that I've found on the internet (i.e., lighting, distance from 
key backdrop, etc.), but I'm wondering if I can avoid or lessen the problem by dubbing 
directly to FCP from the camera right here in my studio. 

My question is, would the chroma-key problem be lessened or even eliminated with no 
generation loss by using this technique, or will the compression problem still exist?

Larry replies: James, you can try this, but a much faster and better approach is to change the way you 
are keying. Do your MiniDV keys using Primatte RT in Motion, or DV Matte Blast from DV Garage.

UPDATE - Dec. 27, 2007

http://www.larryjordan.biz/articles/lj_compress.html
http://www.dvgarage.com/prod/prod.php?prod=dvmatteb
http://www.dvgarage.com/prod/prod.php?prod=dvmatteb


Tom Wolsky, however, disagrees:

This is not something I would recommend. Primatte is really a color difference keyer, 
which does not work well with DV material. It's great for high res, Pro Res and 
uncompressed, media, but not great with media where pixelization changes from frame to 
frame like DV. 
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Getting Progressive Video from the Canon HV20

Brett Murphy writes:

I was just reading your HDV page and was interested in the part about the Canon HV20. 
You can get true progressive 24p from the camera by removing the pulldown. Here is a 
link from Apple that explains the two methods used.

Larry replies: Thanks, Brett, for sharing this. The HV20 is a VERY popular camera - I appreciate the 
suggestion on how to make it's images look better.
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TypeIt4Me Causing Problems

Richard Day, of Grant MacEwan College, sent in this tip:

I was wracking my brains, finding a new problem in FCP: I could SHIFT-I to go to the in 
point, but then if I tried to go to the out point, FCP would instead SET the out point the 
same as the in point! The same thing would happen if I did it going to the out point first, 
then the in point.

After reinstalling and a few other things, I realized I'd turned on a new feature in TypIt4Me 
called "No DOuble CAps". It prevents more than one capital letter being typed -- which is 
what you do if you successively do a GO TO IN and then GO TO OUT in FCP! It's the 
same as typing "IO".

You can add FCP to a list of programs where TypIt4Me is disabled: it's a preference in 
TypeIt4Me. Perhaps this will help someone!

Larry replies: Richard, thanks for this tip!
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Handy-Dandy Grid

Paul Corker, of Penzance Cornwall UK, sends in our last tip for this issue: 

I have seen your training and the section about 
video generators and the ability to use "grids". I 

http://docs.info.apple.com/article.html?artnum=306389
http://docs.info.apple.com/article.html?artnum=306389
http://www.larryjordan.biz/goodies/cyan-grid.tif
http://www.larryjordan.biz/goodies/cyan-grid.tif


found it very helpful but wanted to save my chosen 
grid separately - had a hard time!

So attached is a Cyan Grid 800 pix by 600 pix x 72 
created as a Tiff file in Photoshop which you can 
import into Final Cut. Add it to a track in your 
timeline above the clips you want the grid to appear, 
then use Modify > Composite Mode > Multiply to 
superimpose it. Hope this is helpful.

Larry replies: Thanks, Paul, for sending this in. If you'd like to download this, click here (1.5 MB).

Here's a sample of what the grid looks like in action, composited using Multiply mode: 

UPDATE - Dec. 27, 2007

Jonathan Kirsch writes:

I'm sure you already know about it, but Digital Heaven has a plug-in that generates grids...
handy itself. It's free and you can get it here. 

[ Go to Top. ] 

Wrap-up

Well, I'm within four weeks of getting caught up with my email backlog -- closer than usual. (Sigh...)

In the meantime, please continue sending me your comments and questions. I love hearing from you 

http://www.larryjordan.biz/goodies/cyan-grid.tif
http://www.digital-heaven.co.uk/freeware/dh_grid.php +


and enjoy the conversations that develop around these stories.

Also, please take a few minutes, and: 

1.  Register for our UK seminars.
2.  visit our store and buy something.

Your support for our seminars and products allows me to keep this newsletter free. 

Thanks for all your comments and questions. I love hearing from you because when we share our ideas 
and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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